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AKVIS LIGHTSHOP 8.0 | LIGHT AND STAR EFFECTS

AKVIS LightShop offers advanced lighting techniques for adding stars and glow effects to images.

People by their nature are attracted by things that shine, sparkle, glow and glitter.

Light effects can brighten up any photo: make it look more natural (by adding reflections on shiny objects) or on the contrary
- add a bit of magic and fantasy. Just a few clicks and the eyes of your loved one sparkle like diamonds; some simple
manipulations and a moonlit road appears in night scenery.

AKVIS LightShop helps you create amazing light effects: flares on the sun, lights from distant planets and stars, alien signs
blazing in the night sky, a colorful rainbow over a city, reflections in raindrops, fireworks - wherever your imagination may
take you!

It is easy to find many uses for light effects. You can apply reflections and glows to glamour photography - to make jewelry
and precious stones sparkle on the images of celebrities; or use effects in advertisement catalogues to draw attention to
exclusive articles. Christmas postcards can not do without magic lights and glows. Dull landscape shots can be saved by the
sun rays or reflections on water.
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AKVIS LightShop lets you create an infinite number of light and star effects!

Unleash your imagination! Try the program right now. For your convenience the program includes 149 ready-to-use light
effects divided in 12 groups. First you can train on available light effects and then make your unique ones. A bit of practice
and you can create the most extraordinary effects.
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AKVIS LightShop provides complete control over the light effects, allows you adjust the effect area, its fading, color,
brightness, and opacity. The program is equipped with a variety of elements for creation of light effects. You can move or
change any element of the effect, adjust the way the effect blends with the image.
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In addition to the light effects the program offers the exclusive Sparkle Brush tool that lets you add glowing light spots of
different shapes, colors, and sizes to an image. Draw with this brush over the picture to create impressive scattering stars,
shining hearts and flowers, glares and lens flares, bokeh and magic pixie dust effects, fireworks and snowflakes, sparkle trails,
festive frames and inscriptions... The only limit is your fantasy!

AKVIS LightShop is available as a standalone application as well as a plugin for AliveColors, Photoshop, Corel PaintShop Pro
and other graphics editors. Look at the compatibility page for more details.
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INSTALLATION ON WINDOWS

Please find instructions below on how to install the AKVIS programs on Windows.

You must have administrator rights to install the program on your computer.

Before installing the AKVIS plugins, please make sure that the image editor where you want to install the plugins, is closed. Or
re-run the image editor after the installation of the plugin.

 

1. Run the setup exe file.
2. Select your language and press the Install button.
3. To continue the installation process you have to read and accept the End User License Agreement.

Activate the check box "I accept the terms in the License Agreement", and press Next.

4. To install the Plugin, select your photo editor(s) from the list.

To install the Standalone version, make sure that the corresponding option is activated. 
To create a shortcut for the program on desktop, activate Desktop Shortcut.

Press Next.

5. Press the Install button.
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6. The installation is in progress.

7. The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates, events, and special offers. Enter your e-
mail address and confirm that you accept the Privacy Policy.
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8. Press Finish.

After installation of the standalone version, you will see the program name in the Start menu and a shortcut on the
desktop, if during installation the corresponding option was enabled.

After installation of the plugin, you will see a new item in the Filter/Effects menu of your photo editor. For example in
Photoshop: Filter -> AKVIS –> Lightshop, in AliveColors: Effects -> AKVIS –> Lightshop.
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INSTALLATION ON MAC

Follow the instructions to install the AKVIS software on a Mac computer.

You must have administrator rights to install the program on your computer.

 

1. Open the dmg file:

- akvis-lightshop-app.dmg to install the Standalone version

- akvis-lightshop-plugin.dmg to install the Plugin into your image editor.

2. Read the License Agreement and press Agree, if you agree with the conditions.

3. Finder will open with AKVIS Lightshop application or AKVIS Lightshop PlugIn inside.

 

4. To install the Standalone version, drag the AKVIS Lightshop app into the folder Applications (or any other place you
like).

To install the Plugin, drag the entire AKVIS Lightshop PlugIn folder into the Plug-Ins folder of your graphic editor:

AliveColors: You can choose in the Preferences the folder of the plugins.

Photoshop CC 2023, CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5:
Library/Application Support/Adobe/Plug-Ins/CC;

Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins;

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-ins.
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AKVIS Plugins on Mac
(click to enlarge)

After installation of the plugin, you will see a new item in the filters/effects menu of your photo editor. Select in Photoshop:
Filter -> AKVIS -> Lightshop, in AliveColors: Effects -> AKVIS -> Lightshop.

Run the standalone application by double-clicking on its icon in Finder.

You can also run the AKVIS programs from the Photos app by choosing the Image -> Edit With command (in High Sierra and
later versions of macOS).
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INSTALLATION ON LINUX

Follow the instructions to install the AKVIS software on a Linux computer.

Note: The AKVIS programs are compatible with Linux kernel 5.0+ 64-bit. You can find out the kernel version using
the uname -srm command.

 

Installation on Debian-based systems:

Note: You need apt-install or apt-get permissions required to install software.

1. Run the terminal.
2. Create a directory to store keys: 

sudo mkdir -p /usr/share/keyrings
3. Download the key that signed the repository: 

curl -fsSL https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 
or wget -O - https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null

4. Add the repository to the list where the system looks for packages to install: 
echo 'deb [arch-=i386 signed-by=/usr/share/keyrings/akvis.gpg] https://akvis-
deb.sfo2.cdn.digitaloceanspaces.com akvis non-free' | sudo tee /etc/apt/sources.list.d/akvis.list

5. Update the list of known packages: 
sudo apt-get update

6. Install AKVIS Lightshop 
sudo apt-get install akvis-lightshop

7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates, use the command: 
sudo apt-get upgrade

To remove the program: 
sudo apt-get remove akvis-lightshop --autoremove

 

Installation on RPM-based systems (CentOS, RHEL, Fedora):

1. Run the terminal.
2. Register the key that signed the repository: 

sudo rpm --import https://akvis.com/akvis.asc
3. Add the repository to the system: 

sudo wget -O /etc/yum.repos.d/akvis.repo https://akvis.com/akvis.repo
4. Update the package list:

when using the dnf package manager: 
sudo dnf update

when using the yum package manager: 
sudo yum update

5. Install AKVIS Lightshop:

when using the dnf package manager: 
sudo dnf install akvis-lightshop

when using the yum package manager: 
sudo yum install akvis-lightshop

6. The installation is completed.

Launch the program via the terminal or using the program shortcut.

7. For automatic updates:

when using the dnf package manager: 
sudo dnf upgrade

when using the yum package manager: 
sudo yum upgrade

8. To remove the program:

when using the dnf package manager: 
sudo dnf remove akvis-lightshop

when using the yum package manager: 
sudo yum remove akvis-lightshop
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Installation on openSUSE.

1. Run the terminal.
2. Login as a root user.
3. Add the key that signed the repository: 

rpm --import http://akvis.com/akvis.asc
4. Add the repository to the system: 

zypper ar -r https://akvis.com/akvis.repo akvis
5. Update the package list: 

zypper ref
6. Install AKVIS Lightshop: 

zypper install akvis-lightshop
7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates: 
zypper update

To remove the program: 
zypper remove akvis-lightshop

 

In order to display the program interface correctly, it is recommended to install the Compton or Picom composite manager.
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AKVIS SOFTWARE ACTIVATION

Attention! During the activation process your computer must be connected to Internet.

If it is not possible, we offer you an alternative way (see below for Offline Activation).

 

Download AKVIS Lightshop and install the program. Read the Installation Instruction here.

When you run the unregistered version, a splash window will appear displaying general information about the version and the
number of days left in your trial period.

You can also open the About the Program window by pressing the button  in the program's Control Panel.

 

Click on TRY IT to evaluate the software. A new window will appear with variants of licenses to test.

You do not need to register the trial version to try all features of the software. Just use the program during the evaluation
time (10 days after the 1st start).

During the test period you can try all options and choose the license you like. Select one of the offered functionality types:
Home (Plugin or Standalone), Home Deluxe, or Business. Your choice of license will affect which features will be available
in the program. Consult the comparison table for more details about license types and versions of the software.

If the trial period has expired, the TRY IT button is disabled.

 

Click on BUY NOW to choose a license to order.

When the payment is effected, your serial number for the program will be sent to you within minutes.

 

Click on ACTIVATE to start the activation process.
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Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

Direct connection:

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press ACTIVATE.

Your registration is completed!

Request by e-mail:

In case you have chosen activation by e-mail, a message with all necessary information will be created by the program.

NOTE: You can also use this method for Offline Activation:

If your computer is not connected to Internet, transfer the activation message to a computer connected to Internet,
for example, with a USB stick. Send us this information to: activate@akvis.com.

Please do not send the screenshot! Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (Lightshop.lic) using this information and will send it to your e-mail address.

Save the .lic file (do not open it!) to your computer where you want to register the software, in the AKVIS folder in
Users’ Shared (Public) Documents:

Windows:

C:\Users\Public\Documents\AKVIS

(This PC > Local Disk (C:) > Users > Public > Documents > AKVIS)

Mac:

/Users/Shared/AKVIS

Open the Finder,  se l ec t  the  Go menu,  then se lec t  Go to Folder... (⌘ +Shift+G ) ,  t ype

"/Users/Shared/AKVIS", and click Go.

Linux:

/var/lib/AKVIS

Your registration is completed!
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When the program is registered, BUY NOW turns to UPGRADE that lets you improve your license (for example, change
Home to Home Deluxe or Business).
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WORKSPACE

AKVIS LightShop can work independently as a standalone program as well as a plug-in to a photo editor.

Standalone is an independent program. You can run it in the usual way.

Plugin is an add-on for a photo editor, for example for Photoshop. To call the plugin, select AKVIS –> LightShop from
filters of your image editing program.

 

The workspace view depends on which editing mode is chosen in the Control Panel: Express or Advanced.

In Express mode, the program's interface is extremely simplified, with a minimal set of parameters needed to quickly achieve
a satisfactory result.

AKVIS LightShop Workspace (Express)

In Advanced mode, all panels, options, and tools are available; it's possible to drag the floating panels and customize the
workspace.

AKVIS LightShop Workspace (Advanced)

Most of the program's workspace is taken up by the Image Window, above which is the Control Panel with the following
controls:

The button  opens the home page of AKVIS LightShop.

The button  (only in the standalone version) opens the New Image dialog box. The hot-keys are Ctrl+N  on
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Windows, ⌘ +N  on Mac.

The button  (only in the standalone version) opens an image for processing. The hot-keys are Ctrl+O  on

Windows, ⌘ +O  on Mac.

Right mouse click on this button displays the list of recent files. You can change the number of recent documents in the
program's preferences.
The button  (only in the standalone version) saves image to the disk. The hot-keys are Ctrl+S  on Windows,

⌘ +S  on Mac.

The button  (only in the standalone version) prints the image. The hot-keys are Ctrl+P  on Windows, ⌘ +P  on

Mac.
The button  cancels the last operation made with the tools. It is possible to cancel several operations in a row.

The hotkey for the command is Ctrl+Z  on Windows, ⌘ +Z  on Mac.

The button  returns the last cancelled operation. It is possible to return several operations in a row. The hotkey for

the command is Ctrl+Y  on Windows, ⌘ +Y  on Mac.

The button  shows/hides the background image. If the background image is invisible, the light effect is displayed on

a transparency.
The button  (in Advanced mode) shows/hides the protective selection which indicates the areas excluded from

the light effect.
The button  /  turns the effect on/off.

The button  (in Advanced mode) shows the menu that lets managing the program's workspace and the list of the

saved workspaces. You can customize your workspace by moving the panels, save it, and switch between the
workspaces using the commands in this menu.

Reset - it restores the state of the workspace that was active when launching the program;

Default - it restores the default program's workspace;

Save - it saves the current states of the workspace;

Delete - it removes the selected workspace.

The button  (only in the plugin version) applies the result to the image and closes the plugin.

The button  calls information about the program.

The button  calls the Help files. The hot-key is F1 .

The button  calls the Preferences dialog box for changing the program’s options.

The button  opens a window showing the latest news about LightShop.

 

There are these floating panels in the program: Navigator, Toolbar, Effects, Effect Parameters, Elements, Element
Properties, Tool Options, and Hints. In Advanced mode, all these panels are available, you can drag them in any position,
combine with other panels, scale them or minimize. In Express mode, some of the panels are hidden.

 

Navigate and scale the image using the Navigator. The frame in the Navigator surrounds the area of the image which is
visible in the Image Window; the area outside of the frame will be shaded. The frame can be dragged, thereby changing the
visible portion of the image. To move the frame, place the cursor within it, left click the mouse, and then drag.

Navigator

Use the slider to scale the image in the Image Window. When you move the slider to the right, the image scale increases.
When you move the slider to the left, the image scale decreases.

To scroll the image in the Image Window you can press the spacebar on the keyboard and drag the image with the left
mouse button. Use the scroll wheel of the mouse to move the image up/down, by keeping the Ctrl  key pressed (Mac: ⌘ ) –
to the left/to the right, by keeping the Alt  key pressed (Mac: Option ) − scale the image. Right-click the scroll bar to
activate the quick navigation menu.
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You can also change the image scale by entering a new coefficient into the scale field and pressing the button Enter

(Return  in Mac). The drop-down menu shows some frequently used coefficients.

You can use hot-keys to change the image scale +  and Ctrl++  (⌘ ++  in Mac) to increase the image scale and -  and

Ctrl+-  (⌘ +-  in Mac) to reduce the scale.

 

The Hints panel displays the descriptions of the parameters and buttons when you hover over them with the cursor.
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HOW IT WORKS

AKVIS LightShop can be used as a standalone program and as a plugin to a photo editor.

In order to add a light effect to an image, follow the instructions:

Step 1. Load an image into the software.

- If you work with the standalone version:

The dialog box Select File to Open appears if you double-click on the empty workspace of the program or if you
click on  on the Control Panel. The program supports JPEG, PNG, BMP, WEBP, RAW, and TIFF file formats.

- If you work with the plugin:

Open an image in your photo editor by calling the command File -> Open or using the key combination Ctrl+O

on Windows, ⌘ +O  on Mac.

Then call the AKVIS LightShop plugin in the Filter/Effects menu of the photo editor:

in AliveColors: Effects -> AKVIS -> LightShop; 
in Adobe Photoshop: Filter -> AKVIS -> LightShop; 
in Corel PaintShop Pro: Effects -> Plugins -> AKVIS -> LightShop; 
in Corel Photo-Paint: Effects -> AKVIS -> LightShop.

Step 2. The first time the program starts it will be in Express mode, with a simplified interface and a minimal set of
tools designed to quickly achieve a satisfactory result.

AKVIS LightShop Workspace (Express)

Experienced users can work in the advanced editing mode. Switch to this mode by clicking Advanced in the Control
Panel: the interface's appearance will change, providing access to the full functionality of the program.
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AKVIS LightShop Workspace (Advanced)

Step 3. In the Effects panel, you can choose one of the ready-to-use light effects or create your own effect.
Step 4. You can add multicolor particles on the image using the Sparkle Brush .

Step 5. In Advanced mode, it's possible to remove or reduce the light and star effects on certain parts of the image
using the Exclusion Tool . It is only available for the Home Deluxe and Business licenses.

Step 6. In the standalone version, you can also print your result using .

Step 7. Save the result:

- If you work with the standalone program:

Click on the button  to open the Save as dialog box. Enter a name for the file, choose the format (TIFF,

BMP, JPEG, WEBP, or PNG) and indicate the target folder.

- If you work with the plugin:

Apply the result by pressing . The AKVIS LightShop plugin will close and the image will appear in the

workspace of the photo editor.

Call the Save As dialog box using the command File -> Save As, enter a name for the file, choose the format
and indicate the target folder.

Light Effect

 

Note: To get a light effect on a transparent background, hide the background image , then apply/save the result.

In the standalone version use the PNG format.
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LIGHT EFFECTS

AKVIS LightShop lets you create amazing light effects.

The Effects panel offers a number of ready-to-use light effects (presets) that can be applied in their initial version or can be
modified. First you can train on available light effects and then create your exclusive ones.

Effects Panel

You can use these buttons at the bottom of the Effects panel:

To customize the effects view in the panel, click on  and choose between the options (small or large icons).

To collapse all groups use this button .

To apply the chosen effect to an image, double click on it or use the icon  at the bottom part of the panel. To apply

all effects to the same position and with the same size, defined with the Transform tool , activate the Lock

Position check-box in the top part of the panel.

To save a new effect, click on  and specify the group and the name.

To import an effect to the program, click on  and choose an xml file.

To create a new group, click on .

To rename an effect or a group, click on  and enter a new name.

To remove the chosen effect/group, click on  or drag the effect to this icon. You can also use the Delete -key.

Note: You cannot overwrite, remove, or rename the effects marked with  - these are the build-in AKVIS light

effects.

All commands are also available by right-clicking within the panel.
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CREATING LIGHT EFFECTS

The program offers a rich collection of ready-to-use light effects. An effect can be applied in its original form, or can be
modified. Using one of these presets you can create and save your own unique effect.

Each light effect is composed of simple elements. To create a light effect just combine a number of elements and adjust their
position and parameters.

 
Effects Panel

Follow the instructions to create a light effect:

Step 1. When an image is loaded into the program, the last used effect is displayed in the Image Window.

To add another effect to the image choose it in the Effects panel, and double click on it or use the icon  at the

bottom part of the panel.

You can customize the effects view in the panel: click on  and choose between the options (small or large icons).

Step 2. In the Elements panel edit the list of the elements composing the light effect.

You can add new elements and delete them, hide and show, move up and down.

Step 3. Adjust the parameters for the chosen elements in the Element Properties panel. All changes are displayed in
real time.
Step 4. Adjust the entire effect using the Effect Parameters and the tool .

Step 5. You can save your light effect into the Effects list to use it in the future. You will be able to quickly apply it in
its original form, or use it as a basis for generating new effects.

Click on  to save the preset. In the dialog box specify the group, the name and the path where to save the effect.

Note: You cannot overwrite the build-in AKVIS light effects - they are locked .

To import an effect to the program, click on  and choose an xml file. The effect will be added to the current group.

To create a new group, click on . You can drag an effect to another group.

All commands are also available by right-clicking within the Effects panel.

 

AKVIS Lightshop

23



 

Opacity = 50

 

Opacity = 100

EFFECT PARAMETERS

In the Effect Parameters panel you can adjust the settings for the entire effect, with all its elements.

Let's look at every parameter in detail.

Opacity (1-100). This parameter sets the opacity of the light effect. The default value of the parameter is 100, which
means that the light effect is not transparent. If you reduce the value of the parameter, the light effect becomes
transparent.

Blend Mode. You can adjust the way the light effect blends with the image. The program offers 7 modes; the default
mode for the Effect is Pass Through, for Elements and Sparkle Brush - Normal.

Pass Through - in this mode all visible elements in the effect interact with each other and with the background
image using the blend mode chosen in the Element Properties panel.

Normal – in this mode the light effect is applied to the image as it is.
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Plus – in this mode the color and the opacity of the light effect and the image are summarized. When you apply a
light effect on a black background, its original colors do not change; when you apply it to a white background, its
colors become white; when you apply a light effect over any other color, the colors of this light effect get lighter.

Multiply - in this mode the color and the opacity of the light effect and the image multiply. As a result the color
of the light effect gets darker. By multiplying any color on black, you get black; by multiplying any color on white,
you get the original colors (they do not change).

Screen – it is a mode opposite to Multiply. In this mode the inverted values of the light effect and the image are
multiplied componentwise. The resulting color is always lighter; black color of the background does not influence
the color of the light effect, while white color converts any color to white.

Overlay - the calculation formula for the resulting color depends on the difference in brightness between the
pixels of the light effect and those of the image. If the image is brighter than the light effect, the Screen mode
is used; if the image is less bright than the light effect, the pixels blend using the Multiply mode. The neutral
color for this mode is – 50% gray.
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Brightness = 50

 

Brightness = 150

 

Default Colors

 

Changed Colors

Lighten - in this mode the resulting color is made up of the highest values for every channel (RGB) of the two
colors (that of the image and of the light effect). If the pixels of the light effect are lighter than the pixels of the
image, they will not change; if they are darker - they are replaced with the pixels of the image. The neutral color
for this mode is black; applying a light effect on white gives white.

Brightness (1-200). This parameter changes the intensity of the light effect. It influences the size of glow and halo of
the effect. 
The original brightness corresponds to 100; if you set a value larger than 100, the brightness increases, if you set a
value lower than 100 – the brightness decreases.

Color. You can select default colors for all elements in the effect. Glow changes the color of the main part of the
elements, Halo defines the outline color.

To choose a color from the Select Color dialog box, double click on the corresponding plate. To pick a color from the
image or from the applied light effect, left-click on the plate, and the cursor will be transformed into an eyedropper.

Note: The parameters Brightness and Color cannot be changed for these elements: Halo, Light Spots, and Oval
Spots of Light.

Press Defaults to reset the parameters back to their default values.

Click on Reset Transform to reset the changes made with the Transform tool .
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TOOLBAR

The Toolbar in AKVIS LightShop contains the light effect tools and the additional tools. Their options are shown in the Tool
Options panel and in a pop-up box which appears after right-clicking in the image.

 

Light Effect Tools:

Transform tool  lets you transform and move the light effect.

 

Effect Transformation

Adjust the effect area with the markers that appear over the image:

- The center of circle determines the position of the light source. Place the cursor over the circle line, it will look
like a double arrow , and drag with the left mouse button. All elements of the effect will be resized.

- To move the light source, place the cursor inside the circle, it will turn into crossed arrows , and drag with

the left mouse button.

- Use dots over the circle to stretch or compress all elements of the effect.

- To rotate the effect, place the cursor over a square marker, it will turn into a rounded double-sided arrow ,

and move with the left mouse button.

- The straight line defines the direction of appearing halos and glares and moving the elements. Dragging the line 
 you can move the effect as a whole.

- The end point of the straight line lets you rotate the line around the light source and change its length.

You can reset the changes and restore the markers to their initial states using the commands in the pop-up menu that
appears when right-clicking in the image: Reset Transform, Reset Scale, Reset Position, Reset Aspect, Reset
Angle. Also, you can use the Reset Transform button in the Effect Parameters.

 

Sparkle Brush  lets you add multicolor particles to the image. Read more about this tool.

 

Starry Sky
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Light Effect

 

Excluded Area

 

Result

Eraser  helps to remove the particles drawn with the Sparkle Brush tool.

 

Exclusion Tool  lets you select the areas that should be excluded from  ​​the effect. The tool protects the selected

areas keeping their initial state. It helps to remove or reduce the light effect.

Attention! This tool is only available for the Home Deluxe and Business licenses, in Advanced mode.

You can show/hide the protective areas with the button  in the Control Panel. You can also choose how these

areas will look (when visible) using the options:

Filled with Color. The selections are filled with a color, by default red. To change the color, double-click on the
plate and use the Select Color dialog.

Chess Field. The selected areas are filled with a grid of alternating black and white squares.

Opacity (10-90). The parameter adjusts the opacity of the selection.

Eraser  lets you edit the excluded area (protective mask).

 

You can adjust these general options available for all tools:

Brush Size affects the tool's diameter.

Hardness defines the blurriness of the tool's edges. The less the value the more blurry the tool's edges become.

Strength adjusts the intensity of the effect of the tool.

Spacing changes the distribution of the elements which create the line of the brush.

To draw a straight line with the tools use the Shift -key.

 

Additional Tools:

Hand tool  lets you scroll the image when it does not fit within Image Window at the desired scale. To use it click

on the button, bring the cursor over the image, and while keeping the left mouse button pressed move in the desired
direction.

Double-clicking on the tool's icon  on the Toolbar makes the image fit the Image Window.

Zoom tool  changes the image's scale. To zoom in left click on the image. To zoom out left click with Alt  on the

image. Press Z  to quickly access the tool.

Double-clicking on the tool's icon  makes the image scale to 100% (actual size).

 

Also, in the Toolbar, in Express mode, there is the button  /   that lets you show/hide the Effects panel. In

Advanced mode you can drag and minimize all panels with the mouse.
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Star

 

Heart

 

Rose

 

Yellow Stars

 

Blue Stars

SPARKLE BRUSH

Sparkle Brush  lets you add scattering particles of various colors, shapes and sizes to an image.

 
Starry Sky

Use the following options in the Tool Options panel to customize the appearance of elements to add:

Layer Parameters. These parameters change the layer where the Sparkle Brush is used.

Opacity (1-100). The parameter determines the transparency of the background image through the particles.
Blend Mode. Use the drop-down menu to specify how the particles blend with the background image. Read more about
the blend modes.

 

Element Parameters. The group contains the options for particles added with the Sparkle Brush. Adjust these settings,
then draw with the brush over the image.

Shape. From the drop-down list, select one of the available shapes: Star, Heart, Flower, Rose, or Polygon.

Hint. The Heart, Flower, Rose, and Polygon shapes are only available for Home Deluxe and Business licenses.

Color. Choose the primary color of the particles. Double click on the plate and choose a color from the Select Color
dialog box.
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Size = 20

 

Size = 50

 

Rotation = 0

 

Rotation = 30

 

Smoothness = 15

 

Smoothness = 30

 

Random Color = 25

 

Random Color = 75

Size (5-50). The parameter adjusts the primary size of the particles.

General Tab.

Rotation (0-90). This parameter defines the angle of rotation for all particles.

Smoothness (10-30). At low values ​​of the parameter the edges of particles are sharp and clear. Higher values produce
smoother edges.

Random Color (0-100). If the value of the parameter is zero, all particles are drawn with the primary color. Increasing
the value increases the diversity of colors used for drawing the particles.
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Random Size = 20

 

Random Size = 90

 

Random Rotation = 15

 

Random Rotation = 45

 

Fill Type = Entire

 

Fill Type = Hard Outline

 

Blur = 25 
Fill Type = Entire

 

Blur = 75 
Fill Type = Entire

Random Size (0-100). The parameter specifies the deviation from the primary size. If the value is zero, all particles
have the same size. Increasing the value increases the range of the sizes.

Random Rotation (0-45). This parameter specifies the maximum angle of deviation of the particles.

Extra Tab (inactive for the Star shape).

Fill Type. Select a fill type from the drop-down list: Entire, Hard Outline, or Soft Outline.

If the Entire option is selected, the elements will be completely filled with a color. When selecting the Hard Outline or
Soft Outline options, the elements will be displayed as contours.

Blur (10-100). When increasing the parameter value, the particles become blurred. If the Outline fill type is selected,
the contour will become thinner.
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Blur = 25 
Fill Type = Soft Outline

 

Blur = 75 
Fill Type = Soft Outline

 

Glow = 10

 

Glow = 60

 

Pattern = 2

 

Pattern = 5

 

Deformation = -30

 

Deformation = 30

Glow (0-100). When increasing the parameter value, the brightness of the particles increases.

Pattern (1-11). Available for the Flower, Rose, and Polygon shapes. The parameter changes the number of petals of
the flower and the rose shapes and the number of sides of the polygon.

Deformation (-50..50). At positive values the sides of the polygon become semicircular by bending outward. At
negative values the sides become concave and the polygon turns into a star. The parameter is active only for the
Polygon shape.

You can use the Eraser tool  to edit/remove the drawn particles.
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PROGRAM PREFERENCES

Open the Preferences dialog box by pressing on . The window looks like this:

Language. Change the program language by selecting another from the drop-down list.
Interface Scale. Choose the size of the interface elements. When it is set to Auto, the program workspace will
automatically scale to fit the screen resolution.
Interface Theme. Select the style of the program interface: Light, Gray, or Dark.
Initial Image Scale. This parameter defines the way the image is scaled in the Image Window after opening. The
parameter can take one of two values:

- image scaling Fit to view. The scale adjusts so that the image will be completely visible in the Image Window;
- if the option 100% is checked, image doesn’t scale. Generally, when the scale = 100%, only part of the image
will be visible.

Recent Files (available only in the standalone version). The number of recent documents. The list of the recent files,
sorted by time, become visible by right mouse clicking on . Maximum: 30 files.

Lock the Control Panel check-box. It disables the possibility to hide/show the top panel. If the check-box is selected
the panel is always visible.

To save changes made in the Preferences window press OK.

If you need, click on the button Default to come back the default settings.

 

AKVIS Lightshop

33



PRINT IMAGES IN AKVIS LIGHTSHOP

In the standalone version of AKVIS LightShop you can print the image. Press the button  to open the Print options.

Print Options in AKVIS LightShop

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

In the Orientation group, set the position of paper: Portrait (vertically) or Landscape (horizontally).

Click the Page Setup button to open a dialog box to choose the size of the paper and its orientation, as well as the
print margins.

Press the Reset Margins button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters Scale, Width, Height and Fit to Page. These
parameters have no effect on the image itself, just on the print version. You can change the size of the printed image
by entering any value in %, or by entering new values in Width and Height.

To adjust the size of the image to the paper size, select Fit to Page.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate Frame for the image and adjust its width and color.

Choose the Background Color by clicking on the color plate.

In the Page tab, you can adjust printing of the multiple copies of the image on a single sheet.
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Print Page

Copies per Page. It lets you specify the number of copies of the image on one page.
Horizontally and Vertically. These parameters indicate the number of rows and columns for the copies of the
image on the page.
Spacing. The parameter sets the margins between the copies of the image.

In the Poster tab, it's possible to customize printing of the image on multiple pages for the subsequent junction into a
large picture.

Print Poster

Pages. If the check-box is enabled, you can specify the maximum number of the pages in which the image will be
divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the
program will automatically select the optimal number of the pages in accordance with the actual size of the image
(scale = 100%).
Glue Margins. If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins
will be added to the right and to the bottom of each part.
Show Numbers. With the enabled check-box, a sequence number of each part, by a column and a row, will be
printed in the margins.
Lines of Cut. Activate the check-box to display the cut marks in the margins.

To print the image with the chosen parameters, press the Print button. 
To cancel and close the printing options click on Cancel.

Click the Properties... button to open a system dialog box that enables you to access the advanced settings and send the
document to print.
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LIGHT EFFECT ELEMENTS

Any light effect is composed of elements that have their own parameters. You can edit the structure of the effect in the
Elements panel that is visible in the Advanced workspace's mode.

You can use these buttons at the bottom of the panel (all commands are also available by right-clicking within the panel):

To add a new element, click on  and choose from the drop-down list. The new element will be added above the

current one in the Elements panel and displayed in the Image Window.

The selected (editable) element is highlighted in gray in the list of the added elements. Its parameters are available in
the Element Properties panel.

To duplicate the element, click on . The copy of the element will be added above the current one.

Use the buttons  and  to change the position of the element in the list (up or down by one position). Position in

the list specifies the state of the element in the effect: the top element is closer to the foreground, the bottom - to
the background.

The order of the elements can also be changed by dragging them up or down.

Use the visibility indicator /  to hide/show the element in the Image Window. Parameters for the hidden elements

are disabled. To switch a visibility, click on the indicator.
To delete the selected element, click on . You can also drag the element to the icon or use the Delete -key.

Use the Clear button to delete all the items in the list.

 

Adjust the parameters for the selected element in the Element Properties panel. These settings are the same for most
elements:

Position & Size. This group contains parameters for adjusting the location and size of the light element.
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Shift = 100

 

Shift = -100

 

Scale = 50

 

Scale = 100

 

Rotate = 30

 

Rotate = 60

 

Opacity = 25

 

Opacity = 75

Shift (-200..200). The parameter changes the position of the element along a straight line that is shown when the tool 
 is active.

Scale (1-1000). The parameter changes the size of the element.

Rotate (0-359). The parameter turns the element at a chosen angle.

Color. With this group of the parameters you can change the color and transparency of the selected element, as well as the
options for blending with the elements below.

Opacity (1-100). The parameter changes the opacity of the element that lets revealing the underlying elements and
the background image. Lower values make the element more transparent.
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Blend Mode: Normal

 

Blend Mode: Plus

 

Brightness = 50

 

Brightness = 150

 

Glow Color = White
Halo Color = Orange

 

Glow Color = Yellow
Halo Color = Red

Blend Mode. Choose from the drop-down list how the element blends with the underlying elements. The default mode
for the elements is Normal. Read more about the blend modes.

Brightness (1-200). The parameter specifies the intensity of glow. Lower values give soft glow effect. Increasing the
value increases the brightness of the glow.

Color. You can specify two colors (Glow and Halo) for each element. By default, the color plates are empty, and the
program uses the colors selected in the Effect Parameters.

To choose a color from the Select Color dialog box, double click on the corresponding plate. To pick a color from the
image or from the applied light effect, left-click on the plate, and the cursor will be transformed into an eyedropper. To
clear the plate, right-click on it.

 

Special Parameters. In addition to the above-mentioned parameters, each element has a group of special settings. Read
more about them in the pages describing the elements.
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Halo Width = 25

 

Halo Width = 75

 

Strength = 5

 

Strength = 50

LIGHT EFFECTS ELEMENTS: SPHERE

Sphere is a ball-shaped light element with a soft glowing halo surrounding it.

You can transform the light effect using the tool . In the Element Properties panel you can change the Position & Size

and Color for the element.

You can also adjust the special parameters of Sphere:

Halo Width (1-200). Increasing the value of the parameter increases the area of the halo around the element.

Strength (5-75). The parameter changes the brightness of the halo and affects the softness of the element's edges.
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Ring Width = 5

 

Ring Width = 25

 

Halo Width = 10

 

Halo Width = 50

LIGHT EFFECTS ELEMENTS: RING

Ring is a light element in the shape of a ring.

You can transform the light effect using the tool . In the Element Properties panel you can change the Position & Size

and Color for the element.

You can also adjust the special parameters of Ring:

Ring Width (1-100). The parameter changes the width of the ring.

Halo Width (1-100). Increasing the value of the parameter increases the area of the halo around the ring.
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Strength = 10

 

Strength = 40

Strength (5-75). The parameter changes the brightness of the halo and affects the softness of the element's edges.
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Sides = 3

 

Sides = 5

 

Halo Width = 25

 

Halo Width = 75

LIGHT EFFECTS ELEMENTS: POLYGON

Polygon is an element of the light effect in the form of a regular polygon.

You can transform the light effect using the tool . In the Element Properties panel you can change the Position & Size

and Color for the element.

You can also adjust the special parameters of Polygon:

Sides (3-10). The parameter defines a type of a polygon (from triangle to decagon).

Halo Width (1-200). Increasing the value of the parameter increases the area of the halo around the element.
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Strength = 10

 

Strength = 50

Strength (5-75). The parameter changes the brightness of the halo and affects the softness of the element's edges.
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Halo Width = 25

 

Halo Width = 75

 

Strength = 10

 

Strength = 40

LIGHT EFFECTS ELEMENTS: LIGHT STRIPE

Light Stripe is a light element in the form of a luminous straight line.

You can transform the light effect using the tool . In the Element Properties panel you can change the Position & Size

and Color for the element.

You can also adjust the special parameters of Light Stripe:

Halo Width (1-100). Increasing the value of the parameter increases the area of the halo around the element.

Strength (5-75). The parameter changes the brightness of the halo and affects the softness of the element's edges.

AKVIS Lightshop

44



 

Stripe

 

Half of Stripe

Half. When the check-box is enabled only half of the element is shown.
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Lines = 5

 

Lines = 25

 

Random Length = 5

 

Random Length = 50

LIGHT EFFECTS ELEMENTS: LIGHT BEAMS

The Light Beams element represents a set of glowing lines intersecting at one point.

You can transform the light effect using the tool . In the Element Properties panel you can change the Position & Size

and Color for the element.

You can also adjust the special parameters of Light Beams:

Lines (2-100). The parameter defines the number of lines in the element.

Random Length (0-100). This parameter specifies the lines length range. At the minimum value the length of all lines is
the same (maximum). Increasing the parameter increases the range of length of the lines in the element.
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Check-box is disabled

 

Check-box is enabled

 

Halo Width = 10

 

Halo Width = 50

 

Strength = 5

 

Strength = 50

Random Angle. If the check-box is disabled the angles between the rays are the same, if it is enabled they can
randomly vary.

Halo Width (1-100). Increasing the value of the parameter increases the area of the halo around the element.

Strength (5-75). The parameter changes the brightness of the halo and affects the softness of the element's edges.

Random Seed (0-999). This is the starting number for the random number generator that defines the distribution of
lines in the element. It can be any number between 0 and 999; every number produces a unique distribution of lines.
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Element Size = 40

 

Element Size = 120

 

Particles = 10

 

Particles = 50

LIGHT EFFECTS ELEMENTS: PARTICLES

The Particles element has the form of multiple particles spreading out of a single center.

You can transform the light effect using the tool . In the Element Properties panel you can change the Position & Size

and Color for the element.

You can also adjust the special parameters of Particles:

Element Size (1-200). The parameter specifies the size of the element.

Particles (1-100). The parameter defines the number of luminous particles in the element. Increasing the value by 1
increases the number of particles by 10.
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Particle Length = 10

 

Particle Length = 50

 

Random Length = 10

 

Random Length = 100

 

Halo Width = 30

 

Halo Width = 80

Particle Length (1-100). The parameter changes the maximum length of particles. Different particles can have
different lengths, but cannot exceed the specified value.

Random Length (0-100). This parameter specifies the particles length range. Increasing the parameter increases the
range of length of the particles in the element.

Halo Width (1-100). Increasing the value of the parameter increases the area of the halo around the element.

Random Seed (0-999). This is the starting number for the random number generator that defines the distribution of
particles in the element. It can be any number between 0 and 999; every number produces a unique distribution of
particles.
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Rays = 20

 

Rays = 50

 

Ray Length = 50

 

Ray Length = 120

LIGHT EFFECTS ELEMENTS: STAR BURST

Star Burst is a star with randomly distributed rays which are pointed at the ends.

You can transform the light effect using the tool . In the Element Properties panel you can change the Position & Size

and Color for the element.

You can also adjust the special parameters of Star Burst:

Rays (1-128). The parameter changes the number of rays in the element.

Ray Length (10-200). The parameter defines the maximum length of rays in the element. Different rays can have
different lengths, but cannot exceed the specified value.
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Random Length = 25

 

Random Length = 75

 

Ray Width = 25

 

Ray Width = 75

Random Length (0-100). This parameter specifies the rays length range. Increasing the parameter increases the
range of length of the rays in the element.

Ray Width (10-100). The parameter changes the width of rays in the element.

Random Seed (0-999). This is the starting number for the random number generator that defines the distribution of
rays in the element. It can be any number between 0 and 999; every number produces a unique distribution of rays.
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Rays = 5

 

Rays = 15

 

Ray Length = 50

 

Ray Length = 150

LIGHT EFFECTS ELEMENTS: LIGHT EXPLOSION

Light Explosion is an element consisting of randomly distributed light beams that come out of a single center and are
damped at the edges.

You can transform the light effect using the tool . In the Element Properties panel you can change the Position & Size

and Color for the element.

You can also adjust the special parameters of Light Explosion:

Rays (1-72). The parameter changes the number of rays in the element.

Ray Length (10-200). The parameter changes the maximum length of rays. Different rays can have different lengths,
but cannot exceed the specified value.
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Random Length = 5

 

Random Length = 50

 

Ray Width = 10

 

Ray Width = 50

 

Center = 0

 

Center = 5

Random Length (0-100). The parameter specifies the rays length range. At the minimum value the length of all rays is
the same - maximum (= Ray Length). Increasing the parameter increases the range of length of the rays in the
element.

Ray Width (1-100). The parameter changes the width of rays in the element.

Center (0-5). The parameter adds glowing center to the element. Increasing the parameter increases the brightness of
the center.

Random Seed (0-999). This is the starting number for the random number generator that defines the distribution of
rays in the element. It can be any number between 0 and 999; every number produces a unique distribution of rays.
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Rays = 5

 

Rays = 10

 

Width = 25

 

Width = 75

LIGHT EFFECTS ELEMENTS: RAYS

The Rays element has the form of identical diverging beams of rays coming out of a single center and gradually fading.

You can transform the light effect using the tool . In the Element Properties panel you can change the Position & Size

and Color for the element.

You can also adjust the special parameters of Rays:

Rays (1-48). The parameter changes the number of main rays (beams) in the element.

Ray Width (0-100). The parameter changes the width of main rays in the element. The higher the value, the larger the
distance between the inner rays in the beams is.
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Inner Rays = 3

 

Inner Rays = 9

 

Halo Width = 10

 

Halo Width = 50

 

Strength = 5

 

Strength = 15

Inner Rays (1-24). The parameter defines the number of internal rays in each ray in the element.

Halo Width (1-100). Increasing the value of the parameter increases the area of the halo around the element.

Strength (5-40). The parameter changes the brightness of the halo and affects the softness of the element's edges.
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Radius = 25

 

Radius = 75

 

Ring Width = 25

 

Ring Width = 75

LIGHT EFFECTS ELEMENTS: HALO

Halo is a light effect element in the form of a wide rainbow ring.

You can transform the light effect using the tool . In the Element Properties panel you can change the Position & Size

and Color (Blend Mode) for the element.

You can also adjust the special parameters of Halo:

Radius (10-90). The parameter changes the size of the element.

Ring Width (1-100). The parameter specifies the width of the color rings which compose the element.
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Spectrum Shift = 0

 

Spectrum Shift = 50

Spectrum Shift (0-100). This parameter defines the order of the color rings in the element. At higher values the rings
shift toward the center of the element, at lower values - to the edge.
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Spots = 5

 

Spots = 10

 

Spot Size = 10

 

Spot Size = 50

LIGHT EFFECTS ELEMENTS: LIGHT SPOTS

The Light Spots element represents a set of multicolored circles and polygons of any size located on the same line.

You can transform the light effect using the tool . In the Element Properties panel you can change the Position & Size

and Color (Blend Mode) for the element.

You can also adjust the special parameters of Light Spots:

Spots (1-30). The parameter defines the number of spots in the element.

Spot Size (0-100). The parameter changes the size of the spots.

Shape (0-100). The parameter adjusts the number of round and polygonal spots in the element. When the parameter is
set to 0 all the spots are circular, increasing the parameter increases the number of polygons. At the maximum value all
spots have the form of polygons.
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More Round Spots

 

More Polygonal Spots

 

Density = 10

 

Density = 90

 

Sharpen Edges = 10

 

Sharpen Edges = 50

 

Spectrum = 5

 

Spectrum = 75

Density (1-100). Increasing the parameter makes the spots move closer to each other.

Sharpen Edges (1-100). Increasing the parameter makes the edges of the spots more sharp and visible.

Spectrum (0-100). If the value is 0, each spot has one color. Increasing the parameter adds color rings to the spots.
The higher the value, the more rings will be in each spot.
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Fading = 5

 

Fading = 45

Fading (0-100). The parameter changes the transparency of the spots. The larger the spot, the faster it becomes
transparent.

Random Seed (0-999). This is the starting number for the random number generator that defines the distribution of
spots in the element. It can be any number between 0 and 999; every number produces a unique distribution of spots
on the line.
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Spots = 3

 

Spots = 10

 

Density = 10

 

Density = 90

LIGHT EFFECTS ELEMENTS: OVAL LIGHT SPOTS

The Oval Light Spots element has the form of elliptical glares located on the same line.

You can transform the light effect using the tool . In the Element Properties panel you can change the Position & Size

and Color (Blend Mode) for the element.

You can also adjust the special parameters of Oval Light Spots:

Spots (1-20). The parameter defines the number of ellipses in the element.

Density (1-100). Increasing the parameter makes the spots move closer to each other.
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Fading = 5

 

Fading = 25

 

Spectrum = 5

 

Spectrum = 50

Fading (2-100). At the minimum value, the oval spots have sharp edges. The larger the value, the edges are more
blurred and the ellipses are smaller.

Spectrum (0-100). Increasing the parameter adds colors to the spots. The higher the value, the more color rings will
be in each spot.

Random Seed (0-999). This is the starting number for the random number generator that defines the distribution of
spots in the element. It can be any number between 0 and 999; every number produces a unique distribution of spots
on the line.
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Original Image Result

FIREWORKS OVER THE CITY

Let's imagine a city on a usual winter evening. Everyone is busy with their own life. But there is the date that unites all
inhabitants. In this festive night we can see not only stars in the city night sky, but also the colorful lights of fireworks.

With AKVIS LightShop we can turn any ordinary photo into a festive card.

 

Step 1. In AKVIS LightShop, in Advanced mode, switch to the Elements panel and create a new light effect using
the elements Particles and Star Burst.

You can download the effect, open zip and import the xml file into the program (using  in the Effect panel) or create

your own effect.

Adjust the parameters of each element in the Element Properties panel, then settings of the entire effect in the
Effect Parameters panel, to get something like this:

Step 2. Choose the Sparkle Brush  and adjust its options as shown below.
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Using the brush add stars to the image. You can draw stars on the tips of the particles or randomly, wherever you wish,
to obtain the fireworks flash in the sky.

Save the result . You will see the message: "Use the result as a source image?" Click Yes to continue working.

If you use the plugin version, apply the result  and re-launch the plugin.

Step 3. Repeat Steps 1-2 to add more light effects to various parts of the image. Change the size and position of the
effect using the Transform tool . Select another color in the Effect Parameters.

AKVIS Lightshop

64



For each effect you can replace the central element (Star Burst) with any other element, for example, Light Beams
or Rays.

Hint:

You can save any effect as a preset, to use it in future, by clicking on  in the Effects panel.

Note that only light effects can be saved in xml files, not stars created with the brush!

Step 4. Draw multicolor serpentines with small stars in the sky. Use the following settings for the Sparkle Brush :

Draw with the brush some curved lines in various parts of the image. Increase the Star Size and add new lines over the
old ones, but shorter nearly by 1/3.
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Now we have something like this:

If some parts of the sky still seem empty, you can add more colorful stars of different sizes.

As a result, we get this festive night city:

 

Fireworks in the Night Sky 
(Click on the image to open in large size)
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AKVIS PROGRAMS

 

AKVIS AirBrush — Airbrushing Techniques on Your Photos

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool
that sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using
chosen settings of photo-to-painting conversion. More…

 

AKVIS Artifact Remover AI — JPEG-Compressed Image Restoration

AKVIS Artifact Remover AI uses artificial intelligence algorithms to remove JPEG compression artifacts and restore the
quality of compressed images. This program provides 4 image enhancement modes, each involves a unique neural network
developed especially for this occasion. The software is available free of charge for home users. For commercial use, a
Business license is offered. More…

 

AKVIS ArtSuite — Frames and Effects for Your Photos

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and
texture samples that can be used to create a virtually limitless variety of options for generating frames.
Decorate a photo to give it an original and festive look! More…
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AKVIS ArtWork — Collection of Painting & Drawing Techniques

AKVIS ArtWork is photo to painting software designed to imitate different artistic techniques: Oil Painting, Watercolor,
Gouache, Comics, Pen & Ink, Linocut, Stencil, Pastel, and Pointillism. ArtWork helps you to create a piece of art out of any
picture! More…

 

AKVIS Chameleon — Photo Collage Creation

AKVIS Chameleon is a fun to use tool for photo collage creation. It makes the process easy and entertaining. The tool is
very easy to handle as it does not require precise selection of objects.
Using the software you can quickly create your own photo collages. More…

AKVIS Lightshop

68

https://akvis.com/en/artsuite/index.php?utm_source=help
https://akvis.com/en/artwork/index.php?utm_source=help
https://akvis.com/en/artwork/index.php?utm_source=help
https://akvis.com/en/artwork/index.php?utm_source=help
https://akvis.com/en/chameleon/index.php?utm_source=help
https://akvis.com/en/chameleon/index.php?utm_source=help


 

AKVIS Charcoal — Charcoal & Chalk Drawings

AKVIS Charcoal is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can
make professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding
artistic effects, such as sanguine and others. More…

 

AKVIS Coloriage — Add Color to Black and White Photos

AKVIS Coloriage allows colorizing B&W photos and replacing colors in color images, performing selective colorization and
desaturation. It helps to breathe new life into your old family photographs, bring a vintage or artistic appearance to your
digital images. More…

 

AKVIS Decorator — Resurface and Recolor

AKVIS Decorator lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the
volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things
differently. Recoloring is also made easy. More…
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AKVIS Draw — Hand-made Pencil Drawing Effect

AKVIS Draw converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations,
produces both B&W and color drawings. Add a hand-drawn look to your pictures! More…

 

AKVIS Enhancer — Bring Detail To Your Pictures

AKVIS Enhancer is image enhancement software that detects detail in underexposed, overexposed and mid tone areas of a
photo with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve
Detail, Prepress, and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to
a picture, it lets you improve color and adjust tones. More…

 

AKVIS Explosion — Fabulous Particle Explosion Effects

AKVIS Explosion offers creative destruction and particle explosion effects for your photos. It bursts an object and applies
dust and sand particles to an image. With the software, you can create eye-catching graphics in just a few minutes! More…
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AKVIS Frames — Decorate Your Photos with Frames

AKVIS Frames is a free program designed for working with the AKVIS frame packs

 

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

AKVIS HDRFactory lets you create a High Dynamic Range image from a series of shots or from one single photo. The
program can also be used for photo correction. The program brings life and color to your photos! More…

 

AKVIS Inspire AI — Artistic Stylization of Images

AKVIS Inspire AI stylizes images using various samples of painting. The AI-based program applies the color scheme and style
of a selected artwork to a photo creating a new masterpiece. The software includes a gallery of art styles and allows to load
a custom sample. Imitate the style of world famous artists! More…
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AKVIS LightShop — Light and Star Effects

AKVIS LightShop lets you create an infinite number of astounding light effects! The program offers advanced lighting
techniques for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little
magic to your pictures! More…

 

AKVIS Magnifier AI — Enlarge Images & Enhance Quality

AKVIS Magnifier AI allows you to increase the size of photos and improve image quality and appearance. Featuring neural
network-based algorithms, Magnifier AI upscales images to super-high resolution, up to 800%, and produces wall-sized prints.
Improve image resolution, create clear, detailed images with perfect quality! More…

 

AKVIS MakeUp — Retouch Your Portrait Photos!

AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial imperfections making
your skin radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look
your best in every photo with AKVIS MakeUp! More…

AKVIS Lightshop

72

https://akvis.com/en/inspire/index.php?utm_source=help
https://akvis.com/en/lightshop/index.php?utm_source=help
https://akvis.com/en/lightshop/index.php?utm_source=help
https://akvis.com/en/lightshop/index.php?utm_source=help
https://akvis.com/en/magnifier/index.php?utm_source=help
https://akvis.com/en/magnifier/index.php?utm_source=help
https://akvis.com/en/magnifier/index.php?utm_source=help
https://akvis.com/en/makeup/index.php?utm_source=help
https://akvis.com/en/makeup/index.php?utm_source=help


 

AKVIS NatureArt — Bring Nature to Your Photos

AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos. The program
includes a number of effects: Rain

 

AKVIS Neon — Glowing Drawings from Photos

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like
drawn with luminescent ink. More…
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AKVIS Noise Buster AI — Digital Noise Reduction

AKVIS Noise Buster AI is software for noise suppression on digital and scanned images. The program is efficient for removing
any type of digital noise. It reduces both luminance and color noise without spoiling other aspects of photos. The software
includes AI technologies and adjustments for manual refining. More…

 

AKVIS OilPaint — Oil Painting Effect

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes.
The unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can
become a painter! More…

 

AKVIS Pastel — Turn Photos into Pastel Paintings

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one
of the most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More…
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AKVIS Points — Apply Pointillism Effect to Your Photos

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism.
With the software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors!
More…

 

AKVIS Refocus AI — Focus Improvement & Blur Effects

AKVIS Refocus AI improves the sharpness of out-of-focus and blurry photos, enhances the entire image or partially, creating
a selectively focused area. It's also possible to add bokeh and lens blur effects to your photos. The program provides five
image processing modes: Refocus AI, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More…

 

AKVIS Retoucher — Image Restoration Software

AKVIS Retoucher is an efficient program for photo restoration and photo retouching. The software removes dust, scratches,
stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using
the information of the surrounding areas. More…
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AKVIS Sketch — Turn Your Photos into Pencil Sketches

AKVIS Sketch converts photos into amazing pencil drawings. The software creates realistic color artworks and B&W
sketches, imitating the technique of graphite and color pencil. The program offers these photo to drawing conversion styles:
Classic, Artistic, Maestro, and Multistyle, - each with a series of presets. AKVIS Sketch allows you to feel like a real artist!
More…

 

AKVIS SmartMask — Save Time on Complex Selections!

AKVIS SmartMask is an efficient selection tool that saves time and is fun to use. Selection has never been so simple! The
software considerably increases your productivity. You will be freed from boring work and will have more room for creativity
and realization of your ideas. More…

AKVIS Lightshop

76

https://akvis.com/en/retoucher/index.php?utm_source=help
https://akvis.com/en/sketch/index.php?utm_source=help
https://akvis.com/en/sketch/index.php?utm_source=help
https://akvis.com/en/sketch/index.php?utm_source=help
https://akvis.com/en/smartmask/index.php?utm_source=help
https://akvis.com/en/smartmask/index.php?utm_source=help


 

AKVIS Watercolor — Aquarelle Art from Photos

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The program includes two styles
of photo to painting conversion: Classic Watercolor and Contour Watercolor; each comes with a wide range of ready-to-use
presets. The software turns ordinary images into aquarelle pieces of art. More…
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